Alignment of Tools
LEAP 2025 Online Assessment Tools & the Kurzweil3000.com Text-to-Speech Technology
Many of the LEAP Accommodations and Accessibility Features available in the computer-based tests are very similar to features and tools
found in Kurzweil 3000. Kurzweil 3000 is a comprehensive literacy, text-to-speech technology that includes tools for reading, writing, study
skills, test taking, and more.
On the following pages, you’ll see a side-by-side comparison of many of the LEAP Accommodations and Accessibility Tools and some of the
features/tools found in Kurzweil 3000 which are very similar. Giving students access to Kurzweil 3000 throughout the school year can help them
to become familiar with and comfortable in the use of tools such as text-to-speech, sticky notes, highlighters, magnifiers and much more. The
following pages will show the ways in which tools in Kurzweil3000.com align with many of the accommodations on statewide tests.
Below are some links that you may find helpful:


LEAP Accommodations and Accessibility Features User Guide:
http://www.louisianabelieves.com/docs/default-source/assessment/leap-accessibility-and-accommodations-manual.pdf?sfvrsn=10



LEAP 2025 and other Online Practice Tests: https://wbte.drcedirect.com/LA/portals/la)



Grades 3 & 4 ELA & Math Paper & Pencil Tests in Kurzweil format: http://www.louisianabelieves.com/resources/library/practice-tests



IEP Accommodations Page (see page 5) with Kurzweil listed as an accommodation under “Read Aloud:”
http://www.louisianabelieves.com/docs/default-source/assessment/iep-forms.pdf?sfvrsn=14



Login Site for Kurzweil3000.com: www.kurzweil3000.com



Kurzweil3000 Getting Started Guides are available under the Help Tab of Kurzweil3000.com and on our Product Guides page:
https://www.kurzweiledu.com/products/product-guides.html

LEAP 2025 Online

Kurzweil 3000.com

LEAP 2025 Online
Text-to-Speech

Kurzweil3000.com
Text-to-Speech
When a document is open, the Reading control buttons are just above the document.
That document can be opened from the local computer, Google Drive, and other
locations.

To have LEAP 2025 Online read out loud, the student
clicks the “Play” icon. While reading, the Play button
becomes a Pause button, as shown below.
To have text read aloud, the student clicks the read
The round button in the center is “Starting Points,”
which is used for navigation within the document.

button. As it’s reading, the Play

becomes Pause
, which the student would click to stop the reading.
Alternatively, the student can click on the page to stop reading. Use the front/back
arrows
to move forward/back by reading unit. The student can also click on
the page where they want to start reading, click read and it will begin reading at that
location. The
toggles audible speech on/off. In the silent reading mode
,
Kurzweil3000 will continue to “read” the document and will highlight asit reads, it will
just do so silently.
Other tools in the Kurzweil3000.com toolbar are explained under the following sections.

LEAP 2025 Online
Audio Options

To change LEAP 2025 Online audio options, the
student clicks the “Options” button, then select
“Audio Options.” An audio settings tool window
pops up (shown below). From there, the student can
change reading volume and speed. LEAP 2025
Online currently has one voice available.

LEAP 2025 Online
Audio Options (continued)

Kurzweil3000.com
Audio Options

The ability to customize reading is found in Audio Options

The Audio Options menu allows users to select the reading voice, adjust the reading
speed, change the reading unit and reading mode (Note: Volume is changed at the
computer, not in the K3000 program.)

LEAP 2025 Online
Zoom/Magnifier

Kurzweil3000.com
Zoom/Magnifier

Found in the Document View menu

To change LEAP 2025 Online zoom options, the
student clicks the “Magnifier” icon. A zoom settings
tool window pops up (shown below). From there
they can change zoom and use arrow keys to move
across the page.

Uncheck the “fit width” checkbox in order to manually adjust zoom using the slide tool.

LEAP 2025 Online
Line Guide

Kurzweil3000.com
When reading, Kurzweil 3000 uses dual highlighting to bring focus to a specified unit of
text. In the screenshot below, a single sentence is highlighted and each individual word
is highlighted as its read. Reading unit and reading mode can be changed under Audio
Options. Below is an example of the dual highlighted while reading used by Kurzweil.

The Line Guide tool provides a horizontal line that
brings focus to a single line of text. To use the Line

guide, click on the Line Guide button. A single blue
line with a blue “handle” will appear. Click on either
the line of the handle and use your mouse to move
the line or handle up or down.

LEAP 2025 Online
Background Color Settings

To change color options, the student clicks
Options/Color Choices. From there, the background
color of the document can be changed to the user’s
preference.

Kurzweil 3000.com
Background Color Settings

Background color can be changed under the Document View menu. Users can select
from 7 different background colors.

LEAP 2025 Online
Highlighter and Eraser

Kurzweil3000.com
Highlighter and Eraser

Kurzweil3000.com has 6 highlighters, 2 circle tools, a cross out tool, and an eraser under
the Highlight button.

In LEAP 2025 Online, students select “Use Highlighter”
and then click/drag over the text they wish to highlight.
To remove highlights, select “Clear All.”

LEAP 2025 Online
Sticky Note

Kurzweil3000.com
Sticky Note

Sticky note, text notes and bubble notes can be found under Notes.
Sticky notes
can be customized (color, font type, text color, style) and can be hidden. Click on the
plus sign to add a sticky note. Turn easily turn the note feature off once a sticky note has
been added, hit the ESC key.

The Sticky Note allows users to place a short note
almost anywhere within the window that contains a
question, passage, or scenario. Use a note to mark a

special part or to leave a reminder of some
important information in a question, passage, or
scenario.

LEAP 2025 Online
Cross Off Tool

Below is an example of a sticky note in a document.

Kurzweil3000.com
Cross Out Tool

The Cross-Out tool is found under the Highlight tool, along with highlighters, the circle
tools, and the eraser.
Allows users to use process of elimination when
trying to select answers.
The Cross Out tool works very much like a highlighter and can be used
for process of elimination when trying to select answers. Select the tool and then
click/drag over the text that you wish to “cross out.” The Eraser tool will
erase cross outs.

Kurzweil3000.com Document Editing for Optimum Reading Accuracy
(Especially Important for Test-Taking)
Task

Instructions

Locate the
document

Locate the document that you wish to bring into Kurzweil3000.com as an image document. If it is not a PDF, jpg, or
png, open the document in its original application (i.e. Word, PowerPoint, etc); go to File/Save As, and save the
document as a PDF.

Login

Login to Kurzweil3000.com (www.kurzweil3000.com)

Bring the document
into
Kurzweil3000.com

Open the desired image document using the following buttons: Google Drive, Computer, or Upload. (If you select
Computer, the document will open and be automatically saved to your Recently Opened Local Files Folder. To select
Upload, you’ll navigate to the folder in which you wish to save the document (your Private or Public), then click
Upload. The document will not open, but will be uploaded to the specified folder. To open it, navigate to the
document and open it.

Save: As a teacher, it is wise to save a copy of the original document in your Private folder or other location that is
inaccessible to students. You can use the Copy button to create an additional copy of the file to manipulate.

Read/Listen

Listen to Kurzweil 3000 read the document aloud so that you can identify potential reading errors.

Audio Options
You may wish to turn up the reading speed while reading to hear errors, as you are not reading for understanding, but
only to pick up on errors. Adjust reading speed, etc under Audio Options.

Edit for Optimal
Reading Accuracy

The Zone Editor and the Edit Underlying Text editor are both located in the Tools Menu. Note: These are tools that
can be locked for students under My Account/Users/My Team/Miscellaneous Feature Locks.
The document must be in one of your folders in order for you to edit with either the Zone Editor or Edit Underlying
Text.

Tools Menu

Zone Edit the
Document

Zones determine what is read and reading order in an image document. The Zone Editor allows you to change the
properties and reading order of zones, adjust the size of a zone to determine how much text it encloses, add new
zones, delete zones, or designate silent zones. Hovering over a selected zone provides the user with information
regarding the properties of that zone. Likewise, hovering over the list of the types of zones in the zone editor on the
right will also produce a tooltip. Zones can be moved and resized as needed. Zone editing should be done before
adding highlights or notes to a document. The Header/Footer Editor allows you to determine if those will be read. If a
zone is not recognized by Kurzweil3000, it may be necessary to Re-Recognize the page. Override OCR allows you to
type what you want to be said without having to change the text one number or word at a time, handy to use with
math editing.

Edit Underlying Text

The Edit Underlying Text feature allows users to correct pronunciation in image files. When activated, the underlying
text file that Kurzweil 3000 is actually reading will show at the bottom of the screen. The user selects the word that is
being mispronounced in the document and then spells out the correct pronunciation in the “selected word” field at
the bottom.

In the example above, the name “Al” (as in Al Capone) was recognized and pronounced as “A1.” To correct, simply
type the correct spelling (or, in some cases, the phonetic spelling) of the selected word in the “Selected Word” field at
the bottom. Once changes have been made, close the Underlying Text Windows and save changes.

User Level Feature
Locks

Features locks are available as a user level setting and as a doucment level setting. User level feature locks are
described here. Document level features locks are in the next section.

Miscellaneous
Feature Locks

To lock Bubble Note Editing, Zone Editor, and Edit Underlying Text for the students on your team, go to My
Account/Users/MyTeam (it will be yellow)/Miscellaneous Feature Locks. Select those three features, then click Save.

Feature Locks
Features such as vocabulary supports, spell check and others can be disabled for students on a teacher’s team, which
is especially helpful in a test-taking situation. Remember to reset feature locks once the test is completed.

Document Level
Feature Locks
(applies to a
document)

Feature locks can be applied to specific documents; however, they take effect immediately and cannot be undone.
To apply feature locks to a document (which will be locked for all users accessing that document), go to View/Lock
Features.

Once Lock Features has been selected, the teacher can select from the
various categories on the left to determine what items are locked for the
document. Remember, they take effect immediately and cannot be
undone. (Note: Only the Top Level Coordinator of the account can undo
document level feature locks.) As always, it is a good idea to save a copy
of all documents to your Private folder so that you have a backup.

Password Protect
In the View menu

In a test-taking situation, it is a good idea to password protect test documents. This can be done through the View
menu/Set Document Password. This will allow a teacher to copy a secure file into a student folder without risk of it
being opened. It is advisable that teachers never give the document password to a student, but for the teacher to
input that password. It is also advisable that the teacher keep a copy of the file that is not password protected in
her/his private folder or in some other secure location as a backup.

Important Note: There is no way to retrive a forgotten password , so make sure to
record it reliably. Passwords can be changed by the owner of the document.

Copy the document to
the teacher’s Public
folder or to student
folders.
Click in the small check box to the left of the document name, then select Copy.
The document can then be copied to the teacher’s Public folder, individual
student folders, or to multiple student folders. To copy to the teacher’s Public
folder or to an individual student folder, select Copy then navigate
to that student’s Public or Private folder (or a subfolder within one
of those). By selecting “Copy to Multiple,” teachers can copy a
document to multiple student folders at one time. She/he can
create a new folder, can copy to all students Private folders, or can
select specific students to copy to.

In order to manually select students to copy files to, click on the
triangle next to the student name to show their Public and Private
folders. Click in the check box next to the folder in which you wish
to save. (Note: if the student has subfolders in her/his Public
and/or Private Folders, click on the triangle next to the folder to
reveal the subfolders.

Link to How-to-Videos for Kurzweil3000.com. Most show the older user interface, but can still be helpful. Videos that show
the new User Interface are in the folder labeled as such and include some that show document editing.

